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ภาคผนวก 
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ภาคผนวก ก 
ทักษะการออกอาวุธด�วยมือ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ทักษะการออกอาวุธด�วยมือ 
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         1. กาออกหมัดตรง                                                  2. การใช�สันมือ 
 

 
 

3. การใช�หลังมือ 
 

ภาพท่ี 9 ทักษะการออกอาวุธด�วยมือ 
 
 
 

ทักษะการออกอาวุธด�วยเท�า 
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         เตะเฉียงRound Kick                                                  ถีบตรง Front Kick 
 

 

                             
 ถีบข�าง Side Kick     ถีบแบ็คคิก Back Kick 

 
ภาพท่ี 10 ทักษะการออกอาวุธด�วยเท�า  

 
 

ทักษะการทําล�มด�วยมือ 
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ภาพท่ี 11 ทักษะการทําล�มด�วยมือ 
 
 
 
 

ทักษะการทําล�มด�วยเท�า 
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ภาพท่ี 12 ทักษะการทําล�มด�วยเท�า 
 
 
 
 
 
 
 

ทักษะการทําล�มด�วยมือและเท�า 
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ภาพท่ี 13 ทักษะการทําล�มด�วยมือและเท�า 
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ภาคผนวก ข 
แบบบันทึกผลการใช�ทักษะการทําคะแนน 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

แบบบันทึกผลการใช�ทักษะการทําคะแนน 
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ภาพท่ี 14 แบบบันทึกผลการใช�ทักษะการทําคะแนน 

 
 
 

 
 
 
 
 
 

 
 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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ภาคผนวก ค 
 

โปรแกรมชุดอุปกรณ�วิเคราะห�ทักษะกีฬาสปอร�ตโค�ต(Performance Analysis) 
รุ�น Sportcode Elite) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

โปรแกรมชุดอุปกรณ�วิเคราะห�ทักษะกีฬาสปอร�ตโค�ต(Performance Analysis) 
รุ�น Sportcode Elite) 
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โปรแกรมวิเคราะห�ทักษะกีฬาสปอร�ตโค�ต 

 
โปรแกรมวิเคราะห�ทักษะกีฬาสปอร�ตโค�ด 
ยินดีต�อนรับเข�าสู�สปอร�ตโค�ด - การวางแผนอย�างแท�จริง 
 คู!มือนี้จะช!วยคุณเข�าถึงการใช�สปอร�ตโค�ดได�รอบด�าน โดยมีเนื้อหาหลัก ๆ ท่ีสําคัญท้ังในรุ!นอี
ลิทโปรรีวิว และเพลเยอร� คู!มือนี้จะช!วยเสริมการใช�งานสปอร�ตโค�ดของคุณให�มีประสิทธิภาพมาก
ยิ่งข้ึน หากมีข�อสงสัยเก่ียวกับโปรแกรมสปอร�ตโค�ด หรือต�องการข�อมูลเพ่ิมเติม สามารถอีเมล�สอบถาม
ได�ท่ี Support@sportstec.com หรือตัวแทนจําหน!ายท่ีได�รับการแต!งต้ังอย!างเป=นทางการจากบริษัท 
Sportstec 
 
ภาพรวมสปอร�ตโค�ด 
 สปอร�ตโค�ดถูกออกแบบให�ใช�งานง!าย เพียงคุณทําตามทีละข้ันตอน ก็จะพบว!าใช�งานง!าย
และไม!ยุ!งยากซับซ�อนอย!างท่ีคิดต!อไปนี้คือกระบวนการสร�าง Movie (ภาพเคลื่อนไหว) ใหม!ของ
สปอร�ตโค�ด คุณสามารถทําตามคําแนะนําทีละข้ันตอนได�จากเนื้อหาในหน�าถัดไป 

 1. Click ไอคอนสปอร�ตโค�ด บนหน�า Desktop 
 2. สร�าง Code Window (หน�าต!างเก็บข�อมูล) ใหม! ซ่ึงเป=นหน�าต!างท่ีคุณสามารถตัดต!อและ
ใช� Code Buttons (หัวข�อในการเก็บข�อมูล) ท่ีถูกออกแบบไว� เพ่ือใช�ในการแยกแยะลักษณะเหตุการณ�
ต!าง ๆ 
 3. คิดหัวข�อตามลักษณะเหตุการณ�ท่ีคิดว!าจะต�องใช�ในการวิเคราะห�ในอนาคต สร�างและต้ัง
ชื่อ Code Buttons ข้ึนมาตามหัวข�อท่ีคิดไว� ยกตัวอย!างเช!น คุณต�องการ Code (เก็บข�อมูล) นักกีฬา
คนหนึ่ง การเคลื่อนท่ี หรือการทําประตูแต!ละครั้ง แต!ละ Button (หัวข�อ) จะทําหน�าท่ีสร�าง
Instances (ภาพท่ีเก็บตามหัวข�อท่ีกําหนดไว�) ลงใน Timeline (หน�าต!างแสดงภาพและเวลาของ
ข�อมูลท่ีเลือก) 
 4. Capture (การเก ็บภาพ) ภาพเคลื ่อนไหวลงใน Hard Drive และ Code แต !ละ 
Button ในเวลาเดียวกัน 
 5. เมื่อคุณมี Movie และข�อมูลที่ Code ลงใน Timeline แล�ว Movie ทั้งหมดจะลิ้งค�
กับTimeline ไปตลอด พร�อม Instances ท่ีคุณ Code ไว� เพ่ือแสดงลักษณะของเหตุการณ�ท่ีเกิดข้ึน 

6. คุณสามารถวิเคราะห�ผลของเหตุการณ�ต!าง ๆ ได�จาก Timeline หากคุณต�องการแก�ไข 
เพ่ิมหรือลบข�อมูลออกจาก Timeline ก็สามารถทําได�ทันทีบนสปอร�ตโค�ด 
 
ความหมายของศัพท� 
 ในคู!มือนี้จะใช�คําศัพท�เฉพาะเป=นภาษาอังกฤษ เพ่ือให�ตรงกับเมนู  ง!ายต!อการจดจํา และ 
ไม!สิ้นเปลืองคํา ในการอธิบาย ต!อไปนี้คือความหมายของศัพท�หลัก ๆ ท่ีใช�ในสปอร�ตโค�ด 
 Capture : การบันทึกภาพเคลื่อนไหวลงในไฟล�และจัดเก็บไว�ใน Hard Disk ของเครื่อง 

ไม่พบส่วนของรูปที�มี ID ความ
สัมพันธ ์rId15 ในไฟลนี์!
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 Code : ประเภทของข�อมูล เม่ือคุณต�องการเก็บเหตุการณ�บางส!วนใน Movie เพ่ือใช�ในการ
อ�างอิงหรือวิเคราะห� โดยใช� Code Button ในการจัดเก็บ 
 Code Button : เปรียบเสมือนปุ�มสําหรับกดเพ่ือบันทึกลักษณะเหตุการณ�ตามชื่อและเวลา
ท่ีเกิดข้ึนใน Movie ยกตัวอย!างเช!น คุณอาจจะต้ังชื่อว!า “ Goal “ เพ่ือกําหนดเวลาช!วงนั้นว!ามีการทํา
ประตูเกิดข้ึนคุณต�องเป�ดและป�ดเวลาท่ีบันทึกของ Code Button ด�วยตนเอง ยกเว�น Button ท่ีมี
โปรแกรม Lag Time ท่ีช!วยกําหนดเวลาป�ดหรือความยาวของ Instance ได� 
 Code Matrix : ตารางสถิติ 2 มิติ ได�แก! Code Row และ Text label ใน Timeline 
 Database : คือ Timeline อีกแบบหนึ่ง ท่ีเกิดจากการเลือก Instance จาก Timeline 
หรือหลาย Timeline และส!งออกมาสร�าง Timeline ใหม!ท่ีคัดเฉพาะ Instance ท่ีต�องการเท!านั้น 
เป=นการรวบรวมข�อมูลท่ีต�องการเข�ามาอยู!ในไฟล�เดียว 
 Inactive : คือ Button ท่ีไม!ใช�ในการเก็บข�อมูล เพียงแต!เอาไว�ใส!ชื่อแสดงกลุ!ม Button 
และตกแต!ง Codewindowเท!านั้น 
 Instance : คือส!วนหนึ่งของเหตุการณ�และเวลาท่ีบันทึกลงใน Timeline ของแต!ละ Movie 
 Label : คือคําอธิบายเหตุ 
 Lag Time : ช!วยในการกําหนดเวลาสิ้นสุดของ Instance เม่ือมีการคลิก Code Button 
เพ่ือบันทึกข�อมูลลง Instance สปอร�ตโค�ดจะยุติการบันทึกตามระยะเวลาสิ้นสุดท่ีกําหนดโดยอัตโนมัติ 
Lag Time เหมาะสําหรับ Button ท่ีต�องการคลิกเพียงครั้งเดียว โดยจะเริ่มบันทึกข�อมูลเม่ือมีการคลิก
และหยุดบันทึกเม่ือถึงตามระยะเวลาท่ีต้ังไว� 
 Lead Time : คือระยะเวลาเวลาท่ีถูกกําหนดให�เผื่อไว�ก!อนเวลาเริ่มต�นของ Instance เม่ือมี
การ Code เกิดข้ึนสปอร�ตโค�ดจะเผื่อเวลาตามท่ีกําหนดโดยอัตโนมัติเม่ือทําการ Code เสร็จแล�ว 
 Movie : ภาพเหตุการณ�และระยะเวลาท่ีคุณนํามาใช�เป=นแหล!งข�อมูล 
 Package : โฟลเดอร�ท่ีเก็บ Timeline และ Movie เข�าด�วยกัน 
 Timeline : หน�าต!างในรูปของเส�นเวลาท่ีแสดง Instance ท่ีเกิดจาก Code Button ท่ีทํา
การบันทึกไว�ท้ังหมด 
 
เครื่องมือหลักในการทํางานของโปรแกรมสปอร�ตโค�ด 

 
 
นาฬิกาจับเวลา 

 
เปvดไฟล�ท่ีบันทึกไว� 

  

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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ยกเลิกงานล�าสุด 

  
บันทึกไฟล� 

  
เปvดหน�าต�างบันทึกภาพเคล่ือนไหว 

  
ระดับเสียง 

  
ปรับความเร็วของภาพช่ัวคราว 

  
โหมดเล�นภาพครั้งเดียวหรือเล�นวนซํ้า 

  
เดินหน�า / ถอยหลังภาพ 1 วินาที 

  
เล�น / หยุดช่ัวคราว 

  
เดินหน�า / ถอยหลังภาพ 1 เฟรม 

  
แสดงภาพเต็มจอ 

  
แถบเครื่องมือเขียนภาพ 

  
เปvดใช�งานสปอร�ตโค�ด 

 คลิกไอคอนสปอร�ตโค�ด บน Dock ด�านล!าง 
 The Code Window 
 เป=นหน�าต!างแรกท่ีใช�ในการบันทึกข�อมูลจากภาพเคลื่อนไหวท่ีเลือกมาประกอบด�วยหัวข�อ
ต!าง ๆ ท่ีกําหนดไว�ใช�ในการวิเคราะห�ภายหลัง Code Button จะใช�เป=นหัวข�อหลักและกําหนดเวลา
ของเหตุการณ� ดังนั้น Instance ท่ีเกิดข้ึนคือการเลือกศึกษาข�อมูลท่ีตัวเองสนใจโดยเฉพาะคุณ
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สามารถทําการ Code ขณะ Capture Movie เพ่ือประหยัดเวลา หากคุณต�องการเปลี่ยนแปลง 
เพ่ิมเติม หรือลบข�อมูลก็สามารถกลับไป Code ใหม!ได�ตลอดเวลา 

 

 
 แถบเครื่องมือของ Code Window สามารถปรับแต!งได� โดยคลิกส!วนท่ีว!างในทูลบาร�เพ่ือ
ทําการเป�ดหน�าต!างและปรับแต!งตามท่ีคุณต�องการต!อไป 
แถบเครื่องมือของ Code Window จะบรรจุไอคอน 4 ชนิดท่ีทําหน�าท่ีแตกต!างกัน: 
 1. Coding Functions - (Button; Enter; Clear; Reset; Links) เป=นเครื่องมือท่ี ใช� ในการ 
Code ได�แก! หัวข�อ ; หยุด ; ล�าง ; เลิก ; เชื่อมโยง 
 2. Analysis - (Matrix) เป=นเครื่องมือท่ีใช�ในการวิเคราะห� ได�แก! ตารางสถิติ 2 มิติ 
 3. Operating Mode Functions - (Capture; Code; Label; Edit) เป=นเครื่องมือท่ีใช�ใน
การปฏิบัติการ ได�แก! เก็บภาพ; ลงหัวข�อ; ลงรายละเอียดปลีกย!อย; ตัดต!อ 

ข�อสังเกต: ในหน�าต!างของ Operating Modes ตามข�อท่ี 3 โหมดท่ีกําลังใช�อยู! พ้ืนหลัง
ไอคอนจะมืดและทํางานทีละโหมดเท!านั้น 
 4. Display Functions - (Keys; Transparency) เป=นเครื่องมือท่ีใช�ในการแสดงภาพ ได�แก! 
แป`นตัวอักษร; ความโปร!งแสง 
 
ความโปร�งแสงของ Code Window 
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ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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Code Button History 

ใต�แถบเครื่องมือจะมี History Line เพ่ือแสดง Button ท่ีถูกบันทึกท้ังหมดโดย Button ล!าสุด
ท่ีถูกบันทึกจะอยู!ทางด�านขวาสุดรูปสามเหลี่ยมชี้ลงแสดงว!า Button นั้นยังทําการบันทึกอยู!แต!ถ�ารูป
สามเหลี่ยมชี้ข้ึนแสดงว!าหยุดการบันทึกของ Button นั้นเรียบร�อยแล�ว 
 
Button Information Bar 

แถบข�อมูล Button จะปรากฏอยู!ด�านล!างของ Code Input Window เม่ือวาง Cursor ลง
บน Button ชื่อของ Button ก็จะปรากฏข้ึนบนแถบข�อมูลทันที 

 

 
 
ชนิดของSportsCode Button 
 Code Buttonจะแสดงสัญญาลักษณ�รูปเพชร  

 ชื่อใน Code Button คือคําอธิบายของเหตุการณ�และจะปรากฏเป=นชื่อของ Instance 
ใน Timeline ยกตัวอย!างเช!น ‘Shot on Goal’ ในบาสเกตบอลเป=นต�น 

 -  เม่ือทําการ Capture และมีการเลือกใช� Code Button นั้น Timeline จะทําสร�าง 
Row ใหม!ข้ึนมาตามชื่อของ Code Button ไว�แสดงไว�บนคอลัมน�ด�านซ�ายของ Timeline 

 -  รูปเพชรสีแดงหมายความว!า Code Button นี้ต�องคลิก Start และ Stop ด�วยตนเอง 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความ
สัมพันธ ์rId15 ในไฟลนี์!
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ส!วนรูปเพชรสีเขียวหมายความว!า Code Button นี ้ม ี Lag Time และจะ Stop ตามเวลาท่ี
กําหนดหลังจากทําการคลิก 
 
 Label Button 

  
 -  ชื่อใน Label Button คือคําอธิบายลําดับเหตุการณ�ต!อมาของ Code Button โดยจะ

แนบลงในInstance ท่ีทําการ Code ล!าสุดหรือ Code Button ท้ังหมดท่ีเชื่อมโยงไว�เม่ือมีการคลิก
Label Button นั้นยกตัวอย!างเช!น “Three Point” ของ Text Label button จะถูกต้ังข้ึนมาเพ่ือใช� 
‘Shot on Goal’ เป=นต�น 

 -  Label ท่ีแนบใน Instance สามารถเป�ดดูได�โดย วาง Cursor ไว�บน Instance นั้น
ข�อความก็จะปรากฏเหนือเส�น Timeline 
 
 

 Inactive Button 

  
 -  เป=น Button ท่ีไม!ได�ใช�ในการ Code แต!จะใช�สําหรับแสดงหัวข�อเรื่องข�อเสนอแนะหรื

อกราฟ�คประกอบใน Code Window 
  -  คลิก Button ลักษณะนี้จะไม!มีผลอะไรกับ Timeline คือไม!มี Instance ปรากฏข้ึนแต!อย!าง
ใด 
 
 Edit Mode 

 ใช�สําหรับต้ังค!า Code Window และแก�ไข Code Window โดยไอคอน Edit Mode จะ
ปรากฏอยู!ด�านบนของ Code Window พร�อมค!าปรับแต!งต!างๆสําหรับใช�ในการ Code ให�ตรงกับ
เหตุการณ�และข�อมูลประกอบท่ีต�องการระบุลงใน Timeline 

 
 Create/Add New Button สร�างหรือเพ่ิม Button ใหม� 

  
 Create or Add a New Label Button, Inactive or Active Button 
 สร�างหรือเพ่ิม Label Button Inactive หรือ Active Button ใหม! 
 กด Option ค�างไว� คลิกและลาก Code Button ลงในพ้ืนท่ีว!างด�านล!าง หรือสร�าง 
CodeButton ปกติข้ึนมา แล�วไปแก�ไขท่ี Inspector Panel เพ่ือเปลี่ยนเป=น Label Button หรือ 
InactiveButton หรือ Active Button ก็ทําได�เช!นกัน Move a Button เคลื่อนย�าย Button เดียวคลิก
และลากButton ท่ีต�องการไปยังตําแหน!งท่ีต�องการได�เลย 
 ข�อสังเกต:ถ�าใช� Arrow Keys ในการเคลื่อนย�าย ให�ดูว!า Inspector Panel ทําการป�ดแล�ว
หรือยัง Move a Group of Buttons เคลื่อนย�าย Button ท้ังกลุ!ม 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์! ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ์  
rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 1. กด Command และเลือก Button ท่ีต�องการท้ังหมด หรือทํากรอบล�อมกลุ!ม 
Buttonท่ีต�องการ 
 2. คลิกและลากไปยังตําแหน!งท่ีต�องการ ขณะท่ีปุ�ม Command ยังกดค�างอยู!ด�วย 
Duplicate a Button ทําซํ้า Button 
 3. ถ�าต�องการสร�าง Button ท่ีเหมือนกับของเดิมข้ึนมาใหม!อีกอันหนึ่ง ให�คลิก Button
นั้น 1 ครั้ง 
 4. กด Option คลิกและลาก Button ท่ีทําซํ้าไปวางในตําแหน!งอ่ืนใน Code Window 
 5. เปลี่ยนชื่อใหม! แต!เนื้อหาและคําสั่งท่ีตั้งไว�ทุกอย!างยังคงเหมือนเดิมทุกประการ ส!วน  
Hot key จะใช�ได�กับ Button เดียวเท!านั้น ต�องตัดสินใจเลือกว!าจะใช�กับ Button ไหน และกําหนด 
Hotkey ใหม!ให�กับ Button อีกอันหนึ่งต!อไป 
 6. ถ�าต�องการทําซํ้า Button จาก Code Window หนึ่ง ไปอีก Code Window หนึ่ง 
สามารถทําได�โดยกด Option คลิกและลากไปวางบน Code Window อันใหม!ได�เช!นกัน 
 
 Duplicate a Group of Buttons การทําซํ้า Button ท้ังกลุ�ม 
 การทําซํ้า Button ท้ังกลุ!มไปยัง Code Window อีกอันหน่ึง ให�กด Command ค�างไว� 
และคลิกแต!ละ Button ท่ีต�องการ หลังจากนั้นกด Option และ Command พร�อมกัน คลิกและลาก
กลุ!มButton ท่ีเลือกไปลงอีกหน�าต!างหนึ่งได�เลย Resize a Button ปรับขนาด Button 
 1. คลิกท่ีมุมไหนก็ได�ของ Button จะปรากฏสัญลักษณ�ปรับขนาด (Resizing Knob) 
 2. แล�วลากเข�าเพ่ือลดขนาดและลากออกเพ่ือเพ่ิมขนาด Delete a Button ลบท้ิง Button 
คลิก Button ท่ีต�องการจะลบท้ิง แล�วกด Delete บนคีย�บอร�ด 
 

The Inspector Panel 
 

  
 

 เมื ่อเข�า Edit Mode และคลิก Button ที ่ต �องการจะมีส ัญลักษณ�ปรับขนาด 8 ตํา
แแหน!งปรากฏรอบButton นั้นแล�วคลิก Inspector panel ท่ีอยู!บน Toolbar หรือดับเบิ้ลคลิกท่ี 
Button เลยก็ได�ค!าเริ่มต�นของ Inspector Panel จะมีอยู! 4 sections คือ 

 
ซ่ึงจะอธิบายหน�าท่ีของแต!ละส!วนอย!างละเอียดในหน�าถัดไป 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 เพื่อความรวดเร็วในการ Edit ให�เป�ด Inspector Panel ค�างไว�เลยเมื่อต�องการแก�ไข 
Button ไหนก็เข�าไปคลิกท่ี  Button นั้นและ Inspector Panel ก็จะเป=นของ Button นั้นโดย
อัตโนมัติ 
 Button Behavior คุณลักษณะของ Button 

  
 
 Lag Time 
 คือ  เวลาท่ีถูกกําหนดให�ต!อเพ่ิมออกไปหลังจากคลิกเพ่ือทําการ Code แต!ละ Button โดย
ระยะเวลาท่ีกําหนดใน Lag Time จะถูกบวกเพ่ิมลงไปในตอนท�ายของ Instance ใน Timeline เพียง
คลิกในช!องเลือกแล�วใส!เวลาลงไปก็จะได� Lag Time ตามท่ีต�องการ 
Code Button ท่ีกําหนด Lag Time จะมีสัญลักษณ�รูปเพชรสีเขียว  

 ยกตัวอย!างเช!นคุณกําลังทําการ Code Movie โดยกําหนด Lead Time ไว� 6 วินาทีและ
Lag Timeไว� 2 วินาทีสําหรับ Button ท่ีมีชื่อว!า “Goal” เม่ือคุณคลิก Button ระยะเวลารวมของ 
Instanceท่ีเกิดข้ึนบน Timeline จะเท!ากับ 8 วินาที (6+2) 

 Instance ท่ีได�จาก Button ท่ีกําหนด Lead Time และ Lag Time จะมีระยะเวลาคงท่ีทุก
ครั้งท่ีทําการคลิกซ่ึงจะช!วยให�การ Code ทําได�เร็วข้ึนและง!ายข้ึนสําหรับเกมการแข!งขันท่ีแต!ละ
เหตุการณ�เกิดข้ึนเร็วมากและหลากหลายรูปแบบ 

 สําหรับ Re-activate Lag Time จะใช�เพ่ือให�การนับจํานวน Instance ให�มีความแม!นยํา
และยืดเวลาของ Instance ออกไปเม่ือเกิดการคลิก Button ซํ้าก!อน Lag Time ของครั้งแรกยังไม!หมด
โปรแกรมจะทําการรวมท้ัง 2 ครั้งให�เป=น Instance เดียวให� 

 แต!ถ�าไม!เลือกใช�เม่ือคลิก Button ซํ้าอีกครั้งก!อนท่ี Lag Time จะจบโปรแกรมจะหยุดทํา
การ Code ของ Instance ท่ีกําลังบันทึกทันทีและต�องกลับไปคลิก Button นั้นอีกครั้งถ�าต�องสร�าง 
Instanceใหม!ต!อไป 

 
 Block all labels  

 เป=นการกําหนดให� Code Button นั้นไม!เชื่อมโยงกับทุก Text Label ทําให� Instance 
ของ Code Button นั้นจะไม!มี Label หรือหัวข�อย!อยแสดงอยู!เลย 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 Block labels unless last down 

 เลือกใช�ในกรณีท่ีต�องการให�แน!ใจว!า Label จะถูกบันทึกลงใน Instance ท่ีถูกต�องตรงกับ 
Code Button ท่ีคลิกครั้งสุดท�าย 
 
 Populate Codes in timeline 

 บรรจุ Code Rows อัตโนมัติลงใน Timeline จาก Code หรือ Capture mode ท่ีเป�ดใช�
งานอยู! 

 
 Button ID 

 เป=นการใช�เลขประจําตัวแทนชื่อ เพ่ือใช�ในการเขียนคําส่ังทางสถิติ ควรต้ังให�สื่อความหมายได�
ชัดเจนเช!น Player01, Player02, Player03 เป=นต�น สามารถแก�ไขชื่อในคําสั่งทางสถิติและทําการ 
Code ต!อไปได�เลย 

 
 Customized Hot Keys 

 สามารถใช�  Hot Keys แทนการใช�  Mouse คลิกลงไปท่ี Button ได�  ช!วยให�การ Code 
รวดเร็วข้ึนหากพิจารณาดีแล�วจะพบว!า Hot Keys ทํางานได�เร็วกว!าการลาก Mouse เข�าไปคลิก 
Button ขณะทําการ Code Assign Hot Keys คลิกท่ีช!อง Hot Keys แล�วกดปุ�มบนคีย�บอร�ดของ
เครื่องคอมพิวเตอร�ท่ีต�องการให�เป=น Hot Keys ของ Button นั้น สามารถนําปุ�ม Modifier Key 
ได�แก! Command, Option, Control และ Shift มาผสมกับตัวอักษร เพ่ือเพ่ิมจํานวน Hot Keys ให�
มากข้ึนได� โดยกดปุ�ม Modifier Key ก!อน แล�วตามด�วยตัวอักษร Button Type - Label 

  
  

Apply 
 การจับ Label ใส!ลงใน Instance สามารถปรับเปลี่ยนไปมาได�ไม!ว!าจะหลังจาก Activation 

Link หรือก!อน Deactivation Link ดําเนินการเรียบร�อยแล�วคําสั่งนี้จะคัดกรองว!า Label ไหนต�อง
จับใส!หรือไม!จับใส!ลงใน Instance ได�อย!างมีประสิทธิภาพ 
 
 Button Links การเช่ือมโยงการทํางานของ Button 

  
 
 Activation Links - Button to Button 
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 การเชื่อมโยงด�วย Activation Link นี้เม่ือมีการคลิกตัว Button ต�นทางโปรแกรมจะทํา
การ Link ทุกButton ปลายทางให�เป�ดการทํางานเช!นเดียวกันเส�น Activation Link จะเป=นสีเขียวหัว
ลูกศรจะบอกถึงเส�นทางและปลายทางท่ีเชื่อมโยงสามารถเชื่อมโยงจาก Button หนึ่งไปอีก Button  
หนึ่งได�เรื่อยๆทําให�สามารถเป�ดการทํางานหลาย Button ได�ในการคลิก Button เดียวหรือคราวเดียวกัน 

 
 De - activation Links - Button to Button 

 ทํางานตรงกันข�ามกับ Activation Link คือใช�ในการสั่งป�ดการทํางานของ Button อ่ืนๆ
โดย Buttonต�นทางตัวเดียวโดยมีเส�นเป=นสีแดงและลูกศรบอกเส�นทางไปยัง Button ปลายทางแต!ละ
ตัวทุกButton สามารถเป=นตัวต�นทางและเชื่อมโยงไปยังอีก Button ได�เช!นกัน 
 
 Exclusive Links - Code Button to Code Button 

 สามารถเชื่อมโยงกันและสลับกันทํางานได�ตั้งแต! 2 Buttons ข้ึนไปเม่ือคลิกเพ่ือป�ดการทํางาน 
ของ Button ตัวแรกก็จะไปเป�ดการทํางานของ Button ตัวท่ี 2 ทันทีและเม่ือกดป�ดการทํางานของ
Button ตัวท่ี  2 ก็จะไปเป�ดการทํางานของ Button ตัวท่ี  1 โดยอัตโนมัติ ซ่ึงจะแตกต!างจาก
Activation link ท่ี Button ปลายทางท้ังหมดมีหน�าท่ีรับคําสั่งอย!างเดียวจาก Button ต�นทางเม่ือป�ด
การทํางานก็ไม!ส!งผลใดๆต!อ Button ต�นทางเหมาะสําหรับเหตุการณ�ท่ีตรงกันข�ามและการเป�ดป�ด 
Buttonสองตัวสลับไปมาเช!น Offense กับ Defense Possessions เป=นต�น 

 

  
 

 Text Label สามารถทํา Exclusive Link กับ Code Button ได�เช!นกันเม่ือคลิกไปท่ี 
Label Buttonนั้นเนื้อหาของ Label ก็จะเป=นของ Code Button ท่ีเชื่อมโยงนั้นทันที 
 Modes of the Code Window 

  
 เมื่ออยู!ใน Capture Mode และคลิก Button ต!างๆใน Code Window จะเป=นการ

สร�าง Instanceใหม!ใน Timeline ทันทีรวมท้ังสามารถเลือกทํา Mode อ่ืนๆได�ในขณะ Capture 
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 Code Mode จะลง Instance ท่ีถูกสร�างใหม!ตรงตําแหน!งท่ีกําลังเล!นภาพบน Timeline 
เม่ือคลิกButton ก็จะเริ่มสร�าง Instance จากตําแหน!งท่ีภาพกําลังเล!นแต!ถ�ามีกําหนด Lead Time ไว� 
Instanceก็จะเริ่มต�นจากเวลาท่ี Lead Time ไปถึงจุดท่ีหยุดการทํางานของ Button ในกรณีท่ีภาพ
ท้ังหมดถูกบันทึกลงใน Timeline แล�ว Code Mode ก็จะช!วยในการสร�าง Instance ได�อีกทางหนึ่ง
คือเลื่อน Play Head รูปสามเหลี่ยมชี้ลงบนเส�นแสดงเวลาไปยังจุดเริ่มต�นของเหตุการณ�แล�วคลิก 
Button เพ่ือเดินภาพและสร�าง Instance ตามท่ีต�องการต!อไป 

 ระหว!าง Capture ก็สามารถกลับไปทําการ Code เหตุการณ�ท่ีผ!านมาแล�วได�โดยเฉพาะ
อย!างยิ่งในการทํา Live Coding จะช!วยได�มากทีเดียวแต!จะมีช!องว!างของเวลาระหว!าง Capture ไปสู!
Timelineประมาณ 5 วินาทีควรย�อนกลับไปทําหลังจากผ!านไปแล�ว 5 วินาทีจะได� Instance ท่ีถูกต�อง
และแม!นยําท่ีสุด 

 
 Stop Coding 

 ต�องการหยุด Code Movie ให�คลิก Edit ใน Toolbar ของ Code Window 
 Pause / Restart Coding 

 ต�องการ Pause การ Code และ Movie ของ Timeline และ Restart กลับไป Code 
ใหม! 

 
 
 สามารถกด Space bar บนคีย�บอร�ดเพ่ือ Pause และ Restart สลับไปมาได�เลย 

 
เม่ือเป�ด Timeline และ Movie จะปรากฏดังภาพคือ Movie จะอยู!ด�านบนของหน�าจอและ

มี Timeline แนบมาพร�อมกันอยู!ด�านล!างของ Movie 
 
Timeline ประกอบด�วย 
 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 แถบแสดงว!าเป=นชั่วโมงนาทีวินาทีและ 1/100 วินาทีภาพจะเริ่มจาก Play Head รูป
สามเหลี่ยมชี้ลงสามารถเลื่อนไปมาได�ตามต�องการ 
 

  

  
  

The Timeline Toolbar สําหรับแก�ไขและนําเสนอ Instances 

  

  
 
 Play Headเลื่อนไปมาด�วยการคลิกภายในสามเหลี่ยมแล�วลากไปตามแถบแสดงเวลาของ 
Movie 
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 Merge Rows เลือกเล!นภาพท้ังแถวต้ังแต! Instance แรกไล!ไปจนถึงสุดท�ายของแถวท่ีเลือก 
 Sequential Rows เลือกเล!นภาพท้ังแถวโดยเริ่มจากแถวแรกต!อด�วยแถวท่ีสองและต!อไป

จนจบตามจํานวนแถวท่ีเลือก 
 Selection Order เลือกเล!นภาพเฉพาะ Instance ท่ีเลือกท้ังหมด 
 ถ�าเลือก Append Slow ภาพของแต!ละ Instance จะเล!นบนความเร็วปรกติ 1 ครั้งและ

ตามด�วยภาพเดิมช�าอีก 1 ครั้งทันที (ค!าปกติเล!นภาพช�าอยู!ท่ี 50%) 
 ถ�าเลือก Static Text จะแสดงข�อความอธิบายเนื้อหาของแต!ละ Instance ขึ้นเป=นไต

เต้ิลก!อนจะเริ่มเล!นภาพของแต!ละ Instance 
 ถ�าเลือก Instance Notes จะแสดงข�อความท่ีบันทึกเพ่ิมเติมไว�ในกรอบข�อความด�านล!างภาพ 
 ถ�าเลือก Overlay Text ชื่อแถวเลขท่ี Instance และ Text Label จะปรากฏซ�อนอยู!บน

ภาพท่ีจะเล!น 
 Lines คือการกําหนดจํานวนบรรทัดท่ีจะแสดงข�อความบนภาพของ Instance 

 
สร�าง Timeline ใหม� 

 Timeline จะถูกสร�างข้ึนมาพร�อมกับตอน Capture แต!ก็มีโอกาสท่ีจะ Link Timeline 
ใหม!กับ Movieเก!าก็ได�เพ่ือ Code แตกต!างไปจากเดิมหรือมีผู�ใช�หลายคน Code Movie เดียวกันจึง
จําเป=นแยกออกเป=นของเราคนเดียว 
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 1. เข�าไปท่ี File > New > Timeline บน Main Menu Bar 
 2. เลือก Movie ท่ีจะ Link กับ Timeline ใหม! 
 3. Save Timeline ใหม!โดยกดCommand+Sหรือเข�าไปท่ี File > Save บน Main 

Menu Bar 
 คุณสามารถกด Code Mode Button ใน Code Window Toolbar เพ่ือทําการ Code 

Movie ได�หรือสร�างและปรับแต!ง Instance แบบ Manual ได� 
 * ขอแนะนําให�เก็บไฟล�เป=นแพคเกจจะช!วยให� Movie และ Timeline อยู!ด�วยกันตลอด

ช!วยให�สะดวกเม่ือเป�ดใช� 

  
 
Capture 

 Capture คือ  กระบวนการบันทึกภาพวิดีโอจากกล�องจากไฟล�ในคอมพิวเตอร�หรือจาก
แหล!งจัดเก็บวิดีโอต!างๆสามารถเข�าไปโดยตรงได�หลายวิธี 

 Click  (Camera Icon) ใน Main Toolbar 
 หรือเข�าไปท่ี Main Menu: Capture > Open Capture Window 
 หรือ Keyboard Shortcut:  (Command+R) 
 หรือใน Code Window จะมี ให� Click เข�าไป Capture ได�เหมือนกัน 

 
 * ก!อนเป�ด Capture Window ติดต้ังกล�องวิดีโอหรือแหล!งภาพวิดีโอต!างๆเข�าคอมพิวเตอร�

ให�เรียบร�อยก!อน 
 * เม่ือเป�ด Capture Window โปรแกรมจะทําการค�นหาแหล!งภาพถ�าไม!เจอจะเข�าไปท่ี 

Sight Cameraของคอมพิวเตอร�แทนแต!ถ�าไม!ได� ต้ังให�  Sight camera เป=น Default Camera ก็
จะแจ�งว!าไม!พบแหล!งภาพช!วยในการทดสอบว!าแหล!งวิดีโอนั้นๆเชื่อมต!อกับคอมพิวเตอร�ได�หรือไม! 
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 * สายท่ีต!อจากแหล!งภาพจะเป=น Fire Wire Cable ท่ีผ!านตัว Digital Converters ก!อน
เข�าคอมพิวเตอร� 

 
 
 

 Setting Video and Audio Sources 
 ชนิดของภาพวิดีโอและเสียงสามารถต้ังค!าได�ใน Capture Window ซ่ึงอยู!ด�านล!างกรอบภาพ

โดยมีลักษณะตามภาพข�างล!างนี้ 

  
 * ต�องการเลือกแหล!งภาพวิดีโอให�คลิกลูกศรข้ึนลงของช!องด�านซ�ายบนซ่ึงจะมีแหล!งภาพ

ท่ีค�นเจอให�เลือก 
 * ต�องการเลือกแหล!งเสียงให�คลิกลูกศรข้ึนลงของช!องด�านซ�ายล!างก็จะมีแหล!งเสียงท่ี

ค�นเจอให�เลือก 
 * ด�านขวาบนจะใช�สําหรับเลือก Video Codecs หรือ Format ของวิดีโอให�คลิกลูกศรข้ึน

ลงแล�วเลือกให�ตรงกับ Format ของแหล!งวิดีโอ 

  
 ด�านขวาล!างจะมีให�เลือกแหล!งเสียงเช!นกันให�คลิกลูกศรข้ึนลงแล�วเลือกให�ตรงกับ Format

ของแหล!งเสียง 

  
 
 Convert Movie Package 

ใช�ในการแปลงไฟล�วิดีโอให�เป=นไปตามต�องการหลังจากทําการ Capture เสร็จหรือต�องการ 
Save เป=นPackage ไว�ก!อน 

 

  
 
ก!อนเริ่ม Capture โปรแกรมจะให�กําหนดว!าจะเก็บไฟล�ไว�ท่ีไหน จะเลือก Convert Movie 

Packageเพ่ือให�ไฟล�ภาพใช�กับสื่อหรือเครื่องเล!นอะไร เช!น Apple TV, YouTube, iTunes, iPhone, 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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iPad เป= น ต� น  ซ่ึ งจะใช� กั บ  แหล! งภ าพ ท่ี มี  Video Codecs แบบ  Device Native ห รื อ  Apple 
Intermediate Codes เท!านั้นเม่ือทําการเลือกแล�ว โปรแกรมจะสร�าง Extra Movie Package ข้ึนมา
ขณะ Capture และข้ึนหน�าต!าง Export เพ่ือแสดงความคืบหน�าการ Export เป=น Format ตามท่ี
กําหนดไว�แต!แรก 

  
 สามารถ Pause, Cancel หรือ Delete รายการท่ี Export ได�ตลอดเวลา จะมีไอคอน 

Pause และCancel อยู!ด�านขวาส!วน Delete สามารถใช�ปุ�ม Delete บน Keyboard ลบท้ิงได�เลย
หรือจะเลือก Single Movie in Package ก็จะเก็บเป=น Movie Package ปกติให�หลังจาก Capture 
เสร็จแล�ว 
 
 The Capture Window Toolbar 

  
  
 Capture / Stop Button 

  
 กดปุ�ม Capture เพ่ือเริ่มและ Stop เพ่ือหยุด Capture หากคลิกค�างไว�ลูกศรชี้ลงก็จะ

มี Function การทํางานต!างๆให�เลือก 
 Append Capture 

  
 ใช�เม่ือต�องการหยุด Capture เพ่ือออกไปทําเมนูหรือโปรแกรมอ่ืนและกลับมา Capture 

ใหม!ต!อจากจุดท่ีหยุดในภายหลัง 
  
 Pause / Resume 

  
 Pause ใช�ในการหยุด Capture ชั่วคราวและ Resume ใช�ในการกลับมา Capture ต!อใน

กรณีนี้เม่ือ Pause ไว�จะไม!สามารถออกไปใช�โปรแกรมหรือเมนูอ่ืนๆของSportsCodeได� 
 

 Preferences 

  

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ใน
ไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!



99 

 

เข�า Preferences Window 
 
  
 Current Time Display 

 
 แสดงเวลาท่ีทําการ Capture ไปแล�ว 

 
 Basic Capture 

 * ตรวจสอบให�แน!ใจว!ามีการติดต้ังแหล!งภาพวิดีโอและเชื่อมต!อกับคอมพิวเตอร�เป=นท่ี
เรียบร�อยแล�ว 

 * เป�ด Capture Window โดยคลิกไปท่ี Capture Icon บน Main Toolbar แล�ว
คลิกตรง Capture Button สีแดงเพ่ือเริ่ม Capture หากต�องการเข�าเมนูย!อยให�กดลูกศรชี้ลงค�างไว� 

 * ใส!ชื่อไฟล�และโฟลเดอร�ท่ีจะให�จัดเก็บไว�ควรเอาลง Desktop ไว�ก!อนเพราะจะปลอดภัยกว!า
และค�นหาได�ง!าย 

  
 * เม่ือทําการ Capture หน�าต!าง Timeline จะปรากฏข้ึนเพ่ือแสดงข�อมูลท่ีบันทึกและแก�ไข

ขณะ Captureและ Timeline จะขยายไปเรื่องๆตามเวลาท่ี Capture 
 * ใน c 
 Capture Window จะแสดงสถานะต!างๆด�านล!างเช!นความยาวของไฟล�ขนาดของไฟล�และ

ความจุของไฟล� รวมท้ังแสดงขนาดของพ้ืนท่ีว!าง (Available Space) และระยะเวลาท่ีสามารถ 
Capture ได�ตามขนาดของพ้ืนท่ีว!าง 

 * Pause และ Resume Capture ได�ตลอดเวลาหากต�องการหยุดให�คลิก Stop จะมี
ข�อความแสดงว!าการ Capture เสร็จสมบูรณ�แล�ว 

  
 Quick Capture ใช�สําหรับ Capture ภาพและเก็บไฟล�ไว�ก!อนเพ่ือใช�งานภายหลังสามารถ

เข �าไปใช �เมน ูย !อยใน Capture Button ได �เช !นก ันมักจะใช �เมื ่อต �องการ Capture ผ !านทาง 
Remote 
Communications และ ICal Event Captures 
 View Capture Ratio 

  
 คลิก View Ratio ใน Capture Toolbar เม่ือต�องการปรับขนาดของภาพใน Capture 

Windowเป=น 4 : 3 และ 16 : 9 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 Full Screen Capture 

  
 กดปุ�มนี้เพ่ือเลือกดูภาพ Capture เต็มจอเท!านั้นไม!สามารถทําการ Code ได�ขณะแสดง

ภาพและกด Esc เม่ือต�องการกลับหน�าจอปกติ 
 

 Delete a Movie  
 บางครั้ง Movie Files มีขนาดใหญ!เกินว!าพ้ืนท่ีว!างใน Hard Drive และจําเป=นต�องลบออก

เพราะไม!สามารถหาก Hard Drive สํารองได� 
 1. ลาก Movie Package ลงไปใน Trash บน Dock 
 2. เช็คให�แน!ใจว!า Finder ทํางานโดยคลิกบนพ้ืนท่ีว!างในหน�า Desktop 
 3. เข�าไปท่ี Main Menu ของ Finder แล�วเลือก Empty Trash 

ก!อนทําการลบ Movie ท้ิงควรเก็บไฟล� Timeline ใน Package ไว�ก!อนเผื่อวันหลังมีการนํา 
Movieมา Recapture ใหม!โดยทําการสร�างโฟลเดอร�ใหม!ข้ึนมาเพ่ือเก็บไฟล� Timeline และ Save as 
Movieท่ี Recapture ไว�ท่ีเดียวกัน 
 
 Linking Movies  
 Link a Re-Captured Movie to timeline: 

  
 
 Link another Movie to a Timeline 

 * สามารถ Link Timeline กับ Movie อ่ืนได�โดยเป�ด Timeline ข้ึนมา 
 * เข�าไปท่ี Main Menu เลือก File > Link Movie to Timeline Window 
 * เลือก Movie ท่ีต�องการ Link 

 
 Movie Playback  
 Playing any Movie / Pause any Movie 
 มีอยู! 5 วิธีตามภาพด�านล!าง 
 ปุ�ม Play / ดับเบิ้ลคลิกบนภาพ / กด Space Bar / ลูกศรชี้ข้ึน / กดControl+L 
  

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 คลิกปุ�ม Pause / คลิกบนภาพ / กด Space Bar / ลูกศรชี้ลง / กดControl+Kมี 2วิธีใน
การดูภาพแบบ Frame by Frame 
 

 
 
ใช�ลูกศรซ�ายหรือขวาบน Keyboard หรือปุ�ม Forward / Backward บน Main Tool Bar 
 

 

 Go to a Specific Part of the Movie 
 หากต�องการเจาะจงเข�าไปดูส!วนใดส!วนหนึ่งของภาพมีอยู! 3 วิธีคือ 

 1. ลาก Play Head ใน Timeline ไปยังส!วนท่ีต�องการดู 
 2. ใช� Fast Forward หรือ Rewind บน Main Tool Bar 
 3. กดลูกศรซ�ายหรือขวาเพ่ือเลื่อน Play Head 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 Movie Playback Keyboard Control 

 - Up Arrow เล!นภาพ 
 - Down Arrow หยุดภาพ 
 - Right Arrow เลื่อนภาพไปข�างหน�า 0.1 วินาทีทีละเฟรมถ�ากดค�างไว�ภาพจะเดินไป

ข�างหน�าเรื่อยๆอย!างช�าๆ 
 - Left Arrow เลื่อนภาพไปข�างหลัง 0.1 วินาทีทีละเฟรมถ�ากดค�างไว�ภาพจะเดินไปข�าง

หลังเรื่อยๆอย!างช�าๆ 
 - Home ย�าย Play Head ไปท่ีจุดเริ่มต�นของ Movie 
 - End ย�าย Play Head ไปท่ีจุดสิ้นสุดของ Movie 

 
 Creating Instance Movies 

 สามารถสร�าง Instance Movie ใน Timeline ได�หลายแบบ 
 Single Instance 

 - ดู Instance เดียว : Double Click Instance นั้นๆใน Timeline หรือเลือก Instance 

นั้นและกด  Make Move ใน Timeline Tool Bar Make Move ใน Timeline Tool Barใช�
ลูกศรซ�ายหรือขวาบน Keyboard หรือ ปุ�ม Forward / Backward บน Main Tool Bar Make 
Move ใน Timeline Tool Bar 
 

 

 All instances in a Single Row 
 - ดู Instance ท้ังแถวเรียงกัน: เลือกแถวท่ีต�องการดูโดย Click ที่เลขของแถวแล�ว Click 

Make Movie โปรแกรมจะเล!นภาพไล!ตั้งแต! Instance แรกไปจนถึงอันสุดท�ายของแถว 
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 * หรือ Double Click เลขของแถวท่ีต�องการ Instance Movie ของ Instance ท้ังหมดใน
แถวก็จะถูกสร�างข้ึนมาได�เช!นกันและเลือกบันทึกเก็บไว�ต!างหากได�โดยใช�เมนู Saving Instance 
Movies ซ่ึงจะอธิบายต!อไป 
  
 Merge Rows 

 - เลือกดู Instance ท่ีต�องการจากหลายแถวไล!เรียงกันมาคลิกไปท่ี Merge Rows อยู!มุมซ�าย
บนของ Timeline Window อย!าลืม Make Move หรือใช�คําสั่ง OPTION+COMMAND+M เพ่ือเล!น
ภาพ 

 
 Merge Row จะสร�าง Instance Movie และเรียงลําดับตามตําแหน!งใน Timeline หากมี

การเลือก Instance จากหลายๆแถว Merge Row จะรวม Instance เข�าด�วยกันและสร�าง Chapter 
markersถ�ามี Instance ทับซ�อนกัน 

 1. กด Command ค�างไว�แล�วคลิกตรงเลขของแถวเพ่ือเลือกแต!ละแถวท่ีต�องการ 
 2. คลิก Make Movie ใน Timeline Tool Bar โปรแกรมก็จะเล!นภาพของ Instance ไล!

ไปตามลําดับเวลาของ Timeline หรือจะใช� Shortcut, Option+Command+Mเพ่ือเล!นภาพก็ได� 
 
 Sequential Rows 

 เป=นการเป�ดดูภาพของ Instance ท้ังแถวและไล!เรียงลงมาตามลําดับเลขของแถวหากมีการ
เลือก Instance หลายตัวและอยู!ต!างแถวกัน Sequential Rows จะเริ่มจากแถวท่ีมีเลขแถวตํ่าท่ีสุด
และไล!ไปจนถึงแถวท่ีมีเลขแถวสูงท่ีสุดขณะท่ี Instance ของแต!ละแถวก็จะเริ่มจาก Instance ตัวแรก
สุดไล!ไปเรื่อย 

 1.  จัดเรียงลําดับแถวใน Timeline โดยการลากแถวไปวางในตําแหน!งท่ีต�องการ 
 2.  เลือก Sequential Rows ใน Timeline 
 3.  กด Command ค�างไว�แล�วคลิกเลือกแถวท่ีต�องการ 
 4.  คลิก Make Movie บน Timeline Tool Bar หลังจากนั้น Instance ท้ังหมดก็จะถูก

เล!นภาพไล!ไปตามลําดับของแถว 
 

 Selection Order 
 ไล!ดูตามลําดับ Instance ท่ีเลือกในแถวเดียวกันหรือข�ามแถวก็ได� 

 
 1. เลือก Selection Order ใน Timeline 
 2. กด Command ค�างไว�คลิก Instance ท่ีต�องการโดยจะมีตัวเลขแสดงลําดับไล!ไปต้ังแต! 

[1], [2], [3], ......... 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 3. คลิก Make Move บน Timeline Tool Bar หลังจากนั้นจะเริ่มเล!นภาพต้ังแต! 
Instance [1]ไปเรื่อยๆจนจบ 
 
 Presenting Instance Movies Full Screen 
 มีท้ังหมด 3 วิธีในการดูภาพเต็มจอตามภาพประกอบด�านล!างCommand+M / Present 
Movie บน Main Tool Bar / Windows Menu 

 
 
 Stop Presenting a Movie in Full Screen 

 ต�องการหยุดแสดงภาพเต็มจอให�กด Esc บน Keyboard 
 
 Loop Instance Playback 

 ต�องการเล!นภาพซํ้าต!อเนื่อง 
 1.  เลือก Loop บน Main Tool Bar จะเปลี่ยนจาก  
 2.  เล!นภาพ 
 Adjust the Movie Volume ปรับความดังหรือเบาเสียง 
 -  คลิกไปท่ีรูปลําโพงบน Main Tool Bar แล�วลากข้ึนหรือลงเพ่ือเพ่ิมเสียงและเบาเสียง 
 -  ใน Instance จะมีไอคอน Speaker อยู!ด�านล!างซ�ายของ Movie Window ลากปุ�ม 

Control 
เพ่ือปรับเสียงต!อไป 

 -  ใช�ตัวเพ่ิมเสียงและลดเสียงตรง Function Key บน Keyboard 
 
 Resize Movie Window ลดขนาดของหน�าต�างภาพ 

 1.  เลือก Movie Window 
 2.  เข�าไปท่ี Windows บน Main Menu แล�วเลือก Reduce Movie Size หรือ Increase 

Movie Size 
 
 Viewing Text Labels in An Instance 

 1.  เอา Cursor วางแช!ไว�บน Instance จะปรากฏ Text Labels บนแถบข�อความเหนือ 
Play Head ของ Timeline 

 2.  เข�า Edit ใน Main Menu เลือก Edit Instance Labels จะมี Edit Labels 
Windowปรากฏข้ึน เลือก Instance ก็จะแสดง Text Labels ของ Instance นั้นข้ึนมา 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!
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 Closing Movie Windows ปvดหน�าต�างภาพ 

 สามารถป�ดท่ีปุ�มสีแดงบน Movie Window หรือCommand+Iเพ่ือป�ดทุก Window 
 
 Movie Window Sizes and Proportions ขนาดและสัดส�วนของหน�าต�างภาพ 

 SportsCodeจะลดหรือเพ่ิมขนาดของ Movie Window ในสัดส!วนครึ่งหนึ่งของต�นฉบับ
เท!านั้นโดยกดCommand+Shift + เพ่ือเพ่ิมและCommand+Shift - เพ่ือลดหรือเข�าไปท่ี Window
บน Main Menu แล�วเลือก Reduce Movie Size หรือ Increase Movie Size หรือ Shortcut: 
Command+ Shift +>เพ่ือเพ่ิมและCommand+Shift +<เพ่ือลด 
  
 Overlay Two Movies ซ�อนภาพ 2 ภาพ 

 1.  เป�ด 2 Instance ท่ีต�องการข้ึนมา 
 2.  เข�าไปท่ี Windows Menu ใน Main Menu Bar หรือOption+Command+Yเพ่ือทํา

การOverlay หรือซ�อนภาพ 

 
 3. ถ�าต�องการรวม 2 หน�าต!างท่ีทํา Overlay แล�วเข�าด�วยกัน (Align Two Overlaid 

Movies) 
 4. ให�กดShift+Optionแล�วลากภาพจากหน�าต!างหนึ่งไปวางบนตําแหน!งท่ีต�องการของ 

หน�าต!างอีกอันหนึ่ง 
 5. เม่ือเล!นภาพท้ังหน�าต!างบนและหน�าต!างล!างจะอยู!คงตําแหน!งภาพท่ีวางไว�ตามตําแหน!ง 

ปรับระดับความโปร!งใสของภาพ (Transparency Level)สามารถเข�าไปท่ี Windows Menu ใน 
Main Menu Bar หรือ Control+ Option+ 9 เพ่ือลดความโปร!งใสหรือ Control+ Option +0 เพ่ือ
เพ่ิมความโปร!งใสและทําซํ้าไปเรื่อยๆเพ่ือเพ่ิมหรือลดจนได�ความโปร!งใสของภาพตามต�องการ 
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การกลับภาพ 

 
 

 1. เป�ด Instance movie ข้ึนมา 
 2. เข�าไปท่ี Windows Menu แล�วเลือก Flip Movie Horizontally ภาพจะกลับตาม

แนวนอนเช!นผู�เล!นมือซ�ายก็จะกลับเป=นเล!นมือขวาเป=นต�น 
 
 การดูภาพเรียงกันพร�อมกัน Stacking Instance Movies 

 สามารถดูเรียงกันได�ตั้งแต! 2 ภาพข้ึนไปมีข�อจํากัดเดียวท่ีทําให�การดูภาพสะดุดคือความเร็วใน
การประมวลผลของคอมพิวเตอร�และขนาดของภาพซ่ึงมีให�เลือกเรียงหลายแบบเช!น 1x2, 2x2, 4x1
เป=นต�นเม่ือเลือกท่ีเข�าไปดูภาพของหน�าต!างใดหน�าต!างหนึ่งภาพท่ีเหลือจะถูกซ!อนไว�ทันที 
 

  
 1. เป�ด Timeline ท่ีทําการ Code Instance แล�ว 
 2. เลือก Instance อย!างน�อย 3 Instance และเป�ดภาพท้ังหมดข้ึนมา 
 3. ปรับ Play Head ของแต!ละ Instance ให�มีจุดเริ่มต�นท่ี Sync กัน 
 4. เม่ือ Sync Play Head ให�ตรงแล�วกด Command +Y หรือเลือก Stack Instance 

Movies ใน Windows Menu ใน Main Menu Bar 
 5. Stacked Movie หรือหน�าต!างท่ีมีภาพเรียงกันจะออกมาเป=นแบบ 3x1 หรือ 3 ภาพ

เรียงเป=นแถวเดียวทุกครั้ง 
 6. ถ�าต�องการเปลี่ยนเป=น 1x3 หรือกลับไป 3x1 ให�กดControl+Commandแล�วคลิกไปท่ี 

Stack Movie นั้นๆก็จะปรากฏ Pop up Menu ให�เลือก 
 7. ถ�าต�องการสลับตําแหน!งภาพให�กด Command คลิกและลากภาพท่ีต�องการย�ายไปยัง 

ตําแหน!งท่ีต�องการวางภายในหน�าต!างได�เลย 
 8. ต�องการแสดงภาพหรือซ!อนภาพใน Stack ให�ใช� Clapper Icons (รูปป`ายสั่งแอคชั่น)  

โดยคลิกอันท่ีต�องการซ!อนและมีกากบาทบนภาพท่ีซ!อนคลิก Clapper Icon ซํ้าอีกทีภาพก็จะกลับ 
มาเล!นเหมือนเดิม 
 
การ Stacking Timeline Movies 
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 หลังจาก Capture และ Code ภาพจากหลายๆเกมหลายๆมุมเสร็จแล�วสามารถเอา 
Timeline ท่ีทําท้ังหมดมารวมกันเป=น Timeline เดียวและ Link Stack Movie เพ่ือเป�ดดูหลายมุม
พร�อมกันได�การ Stacking Timeline จะรวม Instance ของทุก Timeline ลงมาอยู!ใน Timeline 
ใหม!ถ�ามี Rowเหมือนกันก็จะรวมทุก Row และทุก Instanceเข�าด�วยกัน 

 การ Stacking ท่ีสมบูรณ�แบบต�องมาจากการบันทึกวิดีโอท่ีสัมพันธ�กันตลอดท้ังเกมไม!ว!า
หยุดพักหรือกลับมา Capture ใหม!ต�องตรงกันทุกช1อตควร Capture ก!อนเริ่มแข!งขันซัก 1 - 2 นาที
และบันทึกเสียงด�วยจะได�ทําการ Sync และช!วยในการ Capture ให�ตรงกัน 
 Stacking Timelines มีวิธีการเปvดใช�งานเหมือน Stacking Instance Movies ดังนี้ 

 1. เป�ด Window ท้ังหมดเหลือเพียง Timeline และ Movie Windows ท่ีจะ Stack 
 2. หาจุด Sync ของแต!ละ Timeline และวางตําแหน!ง Play Head ของแต!ละ Timeline 

ให�ตรงจุดและควรขยับ Play Head ให�ย�อนเลยจุดเริ่มต�นไปซัก 2-3 วินาทีโดยกด Option+Left 
Arrow ให�เหมือนกันทุก Timeline หลังจากทําการต้ังจุด Sync แล�วเพ่ือให�มีเวลาเผื่อไว�เล็กน�อย
ก!อนท่ีเริ่มเล!นภาพแรก 

 3.  เลือก File > Stack Timeline Movies 
 4.  ใส!ชื่อไฟล�และ Save ควรเช็คให�ดีก!อนว!าชนิดของ Package ท่ีจะ Save เป=นแบบ 

Standalone หรือ Reference และ Compress หรือบีบอัดภาพให�เป=น Format อะไรแนะนําให� 
Save เป=น Reference Package ก!อนเพ่ือจะได�ดูภาพได�เร็วและอย!าเพ่ิงลบท้ิง Original Movies 
จนกว!าจะตัดสินใจ Save Stack Timeline Movie นั้นๆเป=นแบบ Standalone Package  

 Standalone Package จะมีไฟล�ใหญ!กว!า Reference Package เพราะมี Movie เป=นของ
ตัวเองไม!ต�อง Share หรือหา Movie อ�างอิงเหมือน Reference Package ถ�า Original Movie ถูก
ลบท้ิงก็จะไม!มีภาพข้ึนมาแต! Standalone Package สามารถแสดงภาพได�เพราะ Copy Movie เก็บ
ไว�ด�วยเลยต้ังแต!ทําการ Save 
 
 Combining Instance Movies รวม Instance Movie เข�าด�วยกัน 

 เป=นวิธีการง!ายๆท่ีจะรวม Instance ท่ีมีเนื้อหาเข�ากันแม�จะต!าง Timeline กันและสร�าง
เป=น Instance Movie ใหม!ข้ึนมา 

 1. เป�ด 2 Instance Movie หรือมากกว!าข้ึนมาแบบย�อนหลังคือเป�ด Instance Movie ท่ี 
2 หรือสุดท�ายก!อนแล�วค!อยเป�ด Instance Movie ท่ี 1 จะทําให�ภาพเป�ดเรียงกันเม่ือทําการ 
Combine เสร็จเพราะโปรแกรมจะเลือกเล!นภาพท่ีเป�ดล!าสุดก!อนแล�วค!อยไล!ไปภาพท่ีเป�ดก!อนหน�าถ�า
ลองเป�ด Instance Movie ท่ี 1 เพ่ือให�ข้ึนต�นก!อนแล�วตามด�วย Instance Movie ท่ี 2 พอทําการ 
Combine เสร็จจะกลายเป=นว!า Movie แรกท่ีเล!นคือ Movie ท่ี 2 เพราะเป�ดล!าสุดและตามด�วย 
Movie ท่ี 1ท่ีเป�ดก!อนหน�า 

2. เข�าไปท่ี Windows > Combine Instance Movies ใน Main Menu Bar จะมี
หน�าต!างใหม!เกิดข้ึนมาและเล!นภาพไล!เรียงตามลําดับท่ีวางไว� 

 3. หากต�องการ Save ให�กด Command + S หรือใน File Menu หรือไอคอน Save ใน 
Main Tool Bar 
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 4. เลือก Location ท่ีจะลงและใส!ชื่อไฟล� 
 5. เลือกว!าจะให� Movie เป=น Format อะไร 
 6. คลิก Save 

 
 Working with Code Rows การจัด Code Rows 
 Move a Row ย�ายแถวข้ึนลง 
 คลิกตรงเลขแถวใน Timeline แล�วลากข้ึนหรือลง 

 
 Select Multiple Rows เลือกหลายแถว 

 1. กด Command แล�วคลิกไปท่ีเลขแถวท่ีต�องการ 
 2. หรือเลือกเป=นช!วงให�กด Shift ค�างไว�แล�วลากจากแถวบนสุดลงไปจนถึงแถวล!างสุดท่ี

ต�องการ 
 
 Duplicate, Delete, Edit Code Row Names, Change Code Name Colors  
ต�องการสร�างใหม!ลบท้ิงเปลี่ยนชื่อและเปลี่ยนสีใน Code Rows 

 1. กด Control และคลิกขวาไปท่ีตัวเลขแถว 
 2. จะมี Drop Down menu เป�ดลงมาให�เลือก 

2.1 Edit Row - เปลี่ยนชื่อกับเปลี่ยนสี 
2.2 Add Row - เพ่ิมแถวเปล!า 
2.3 Play Selected Instances - เล!นเฉพาะ Instance ท่ีเลือก 
2.4 Delete Selected Rows – ลบเฉพาะแถวท่ีเลือก 
2.5 Duplicate Selected Rows – สร�างแถวใหม!เหมือนกับแถวท่ีเลือก 

 
 
 Add a New Blank Row to a Timeline เพ่ิมแถวเปล�าในTimeline 

 
 เลือก Rows > Add row จาก Main Menu Bar แถวใหม!จะถูกสร�างต!อจากแถวท่ีเลือกไว�

ตอนแรกหรือเลือกไอคอน New Row ใน Timeline Tool Bar หรือกดCommand+N 
 
 Create a New Row from Selected Instances using New Row + 
 สร�างแถวใหม!พร�อม instance ท่ีเลือกด�วยเมนู New Row + 
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 เลือก Instance ท่ีต�องการท้ังหมดโดยกด Command ค�างไว�แล�วไล!คลิก Instance แต!ละอัน
จนครบหรือคลิกและลากสี่เหลี่ยมครอบกลุ!ม Instance ใน Timeline หรือจะเลือกท้ัง Row ก็ได� 
เม่ือเลือก Instance เสร็จแล�วคลิกไอคอน New Row + ใน Timeline Tool Bar แต!ถ�าไม!ต�องการให� 
Instance ท่ีเวลาตรงกันทับกัน (Merging) ให�กด Option ค�างไว�แล�วค!อยคลิก New Row + โดยท่ัวไป
ถ�ามีหลาย Instance มีการ Overlap หรือทับซ�อนกันโปรแกรมจะรวบเป=น Instance เดียว 
 
 Create a Combination of Rows สร�างแถวใหม�จากการรวมของแถวเก�า 

  
 1. เลือก Rows > Create New Row จาก Main Menu Bar หน�าต!าง Add Row จะ

ปรากฏข้ึนให�เลือก Row ท่ีต�องการ Combine 
 2. ใส!ชื่อ Row ใหม!และใส!ไว�ตรงไหนใน Timeline (Insert row) 
 3. คลิก Combine Rows to form New Row ด�านล!าง 
 4. ใน Row A ให�เลือก Row ท่ีต�องการ 
 5. เลือก Operation : A and B, A or B, not A ตามภาพ 
 6. ใน Row B ให�เลือก Row ท่ี 2 ท่ีต�องการ Combine ด�วย 
 7. เลือกเรียบร�อยและทุกอย!างถูกต�องคลิก Create Row ด�านบนเพ่ือสร�างแถวใหม! 

 
 เทคนิคพิเศษ 

 1. ในกรณีท่ีมีหัวข�อตรงข�ามกันเช!น Team Possession สามารถใช� Not เพ่ือสร�างแถวชื่อ 
Other Team Possession ได�ทันที 

 2. หากต�องการ Combine มากกว!า 2 แถวให�สร�างแถวใหม!ก!อนแล�วเอามา Combine กับ
แถวท่ี 3 ต!อทําแบบนี้ไปเรื่อยๆก็จะได�แถวใหม!ท่ี Combine ครบหมดทุกแถว 
 
 Editing Instances in the Timeline 
 Manually Creating a New Instance สร�าง Instance ใหม!แบบ Manual 

 1. คลิก Code Row Name หรือ Row Number (ถ�าไม!มี Code Row เลยให�สร�าง Row 
ใหม!ข้ึนมาก!อนตามเมนูเรื่อง Add a New Blank Row ในหน�า 39) 

 2. เลื่อน Play Head ใน Timeline ท่ีจุดเริ่มต�นหรือจุดสุดท�าย 
 3. กดOption+Commandแล�วลาก Play Head ไปยังจุดสุดท�ายหรือจุดเริ่มต�น 

4. Instance Movie ใหม!ก็จะปรากฏบน Row ท่ีเลือกไว� 

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!

ไม่พบส่วนของรูปที�มี ID ความสัมพันธ ์rId15 ในไฟลนี์!



110 

 

 
 ใช�Option+Commandเพื่อขยายหรือลดความยาวของ Instance ได�เช!นกันโดยกด

Option+Commandค� างไว� วาง Cursor ขอบซ� ายหรือขอบขวาของ Instance รูป  Cursor จะ
เปลี่ยนเป=นรูปลูกศรชี้ซ�ายขวาคลิกแล�วลากไปตามระยะท่ีต�องการ 
 Instance Edit การแก�ไข Instance 

 1. เลือก Instance ใน Timeline 
 2. เลือก Edit > Instance Edit ใน Main Menu Bar หรือกด Control + E 

Movie Window จะถูกเป�ดข้ึนพร�อมลูกศรชี้ซ�ายขวาอยู!มุมบนท้ังสองข�างของ Window 
 3. กดลูกศรเพื่อลดและขยายความยาวของ Movie โดยลูกศรฝ��งซ�ายจะใช�ในการปรับ

จุดเริ่มต�นของ Movie ส!วนลูกศรฝ��งขวาจะใช�ในการปรับจุดสุดท�ายของ Movie 
 4. Ctrl+Iจะต้ังเวลาเริ่มของ Instance ท่ี เลือกตามตําแหน! งท่ี  Play Head ใน Edit 

Instance Movie Window ต้ังอยู! 
 5. Ctrl+Oจะต้ังเวลาจบของ Instance ท่ี เลือกตามตําแหน!งท่ี  Play Head ใน Edit 

Instance Movie Window ต้ังอยู! 
 6. Ctrl+Tจะตั้งเวลาเริ ่มหรือเวลาจบของ Instance ที ่เลือกตามตําแหน!งที ่ Play 

Head ถ�า Play Head อยู!ด�านหน�าของก่ึงกลางคลิปเม่ือกดCtrl+Tจะเป=นการต้ังจุดเริ่มต�นและถ�าอยู!
ด�านหลังของก่ึงกลางคลิปเม่ือกดCtrl+Tจะเป=นการต้ังจุดสุดท�ายของ Movie 

 7. Shift+Ctrl+Iจะลบเวลาเริ่มต�นลง 0.5 วินาที (จุดเริ่มต�นจะถอยกลับไป 0.5 วินาทีทํา
ให� movie ยาวข้ึน 0.5 วินาทีเช!นกัน) 

 8. Shift+Ctrl+Oจะลบเวลาจบลง 0.5 วินาที (จุดสุดท�ายจะเลื่อนออกไป 0.5 วินาทีทําให� 
Movie ยาวข้ึน 0.5 วินาทีเช!นกัน) 

 9. Shift+Ctrl+Tจะลบเวลาเริ ่มต�น 0.5 วินาทีถ�า Play Head อยู!ใกล�กับจุดเริ ่มต�น
ของ 
Instance แต!ถ�าอยู!ใกล�กับจุดสุดท�ายจะเป=นการขยายเวลาออกไปอีก 0.5 วินาที 
 
 Delete an Instance ลบท้ิง Instance 

 คลิก Instance หนึ่งครั้งกด Delete บน Keyboard เพ่ือลบท้ิง Copy an Instance 
from One Row to Another ทําซํ้า Instance จากแถวหนึ่งไปอีกแถวหนึ่ง 

 1. กด Option 
 2. คลิกและลาก Instance ลงไปแถวใหม! 
 3. ถ�าต�องการ Move Instance นั้นไปเลยให�ลบ Original Instance ท้ิง 

 
 Instance Splitting ต�องการแยก Instance 

 เลื่อน Play Head ไปท่ีจุดท่ีต�องการแยกแล�วเลือก Edit > Instance Split 
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 Combining Timelines นํา 2 Timeline มาเช่ือมต�อกัน 

 สามารถ Combine ได�มากกว!า 2 Timeline ช!วยให�การวิเคราะห�หลาย Movie เป=นไป
อย!างรวดเร็วกระบวนการจัดเก็บจะเป=นแบบ Reference Package เพราะใช�พ้ืนท่ีหน!วยความจําน�อย
แต!ห�ามลบOriginal Movie เด็ดขาดจนกว!าจะ Save เป=น Standalone Package แล�วก็สามารถ
ลบท้ิงได�เพ่ือประหยัดพ้ืนท่ีหน!วยความจํา 

 1. เลือก Combine Timeline Movie จาก File ใน Main Menu Bar 
 2. Locate หรือเลือก Timeline ท่ีต�องการ Combine 
 3. เลือกและเพ่ิม Timeline ลงไปจนครบ 
 4. กด Combine 
 5. ใส!ชื่อไฟล�และ Save 

 
Merging Timelines รวมเนื้อหาของ 2 Timeline มาอยู�ใน Timeline เดียว 

 ในกรณีท่ีมีคน Code 2 คนใน Movie เดียวกันและต�องการเปรียบเทียบผลในการ Code 
หรือต�องการรวมผลท้ังสอง Code มาไว�ใน Timeline เดียวจะใช�เมนูนี้และ Merge หลาย Timeline 
ได�เช!นกัน 

 1. เป�ด 2 Timeline ท่ีใช�หรือมาจาก Movie เดียวกัน 
 2. เลือกแถวท่ีต�องการ Merge ในแต!ละ Timeline หรือเลือกเป=น Instance ก็ได�หากไม!

ต�องการท้ังหมด 
 3. เลือก File > Merge Timeline Windows 
 4. Timeline ใหม!จะถูกสร�างข้ึนพร�อม Row หรือ Instance ท่ีเลือกแต!ยังไม!เชื่อมโยงกับ 

Movie 
 5. เลือก File > Link Movie to Timeline Window แล�วเลือก Movie ต�นฉบับ 
 6. จะเลือก Save แยกเป=น Movie Package ใหม!หรือเก็บไว�ใน Movie Package เดิมก็ได� 

 
Code Matrix ตารางสถิติแบบเมตริกซ� 

 เป=นตารางแบบ 2 มิติแสดงสถิติ Code Rows กับ Text Labels ใน Timeline ท่ีเป�ดอยู! 

แถวจะแสดง Code Rows และคอลัมน�แสดง Text Labels สามารถ Swap Axis   เพ่ือสลับกัน
ได�เซลล�ท่ีมีตัวเลขตรงจุดตัดกันคือ Code Rows ท่ีมีการ Code Text Labels ลงไปแล�วจํานวนท่ีอยู!
ในMatrix คือจํานวนของ Instance ท่ีเกิดข้ึนไม!ใช!จํานวนของ Text labels 
 

ไม่พบส่วนของรูปที�มี ID ความ
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 วิธีใช� Code Matrix 

 1. คลิก  ใน Timeline หรือ Code window 
 2. ดับเบิ้ลคลิก Row Name เพ่ือเป�ดดู Movie ของ Instance ท้ังหมดในแถว 
 3. ดับเบิ้ลคลิก Column Name เพ่ือเป�ด Movie ของ Text Labels ท้ังหมด 
 4. ดับเบิ้ลคลิกไปท่ีตัวเลขในเซลล�เพ่ือเป�ด Movie ของ Instance ท่ีมี Text Labels 
 5. ดับเบิ้ลคลิกท่ีผลรวมของ Row หรือ Column เพ่ือดู Movie ท้ังแถวหรือท้ังคอลัมน� 

 
The Code Matrix Toolbar 
 Adding Columns and Rows เพ่ิมแถวเพ่ิมคอลัมน� 

 ก!อนอ่ืนต�อง Deselect แถวหรือคอลัมน�ท่ีเป�ดโดยคลิกไปท่ีเซลล�หรือพ้ืนท่ีว!างเปล!าใน 
Matrix คลิกไอคอน + มุมซ�ายบนจะมีเมนูข้ึนมาให�เลือกเม่ือทําการเลือกแล�วแถวหรือคอลัมน�นั้นจะ
ข้ึนต!อท�ายแถวหรือคอลัมน�ท่ีมีอยู!แล�ว 

 

 
หรือคลิกขวาท่ีชื่อแถวหรือคอลัมน�จะมี Drop Down Menu ให�เลือก Remove ได�เช!นกัน 

 
จัดเรียงลําดับ Labels, Groups, Rows แบบ Ascending (A-Z) หรือ Descending (Z-A) 

 
เป�ดหน�าสั่งพิมพ� ใส!ชื่อของ Matrix แล�วสั่งพิมพ� 
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คลิกแถวหรือคอลัมน�ไฮไลท�แถวหรือคอลัมน�เลือกเฉพาะ Instances ในตารางแล�วคลิก
ไอคอนนี้เพ่ือเล!น Movie ตามท่ีเลือก 

 
ส!งออกตารางไปยัง Excel หรือ Tab-delimited Text File กดไอคอนนี้ค�างไว�จะมี Drop 

Down Menu ให�เลือกว!าจะ Export ไปท่ีไหน 
 
Duplicating Columns 

 ต�องการสร�างคอลัมน�ใหม!ท่ีทําซํ้ามาจากคอลัมน�เดิมข้ึนมากด Option ค�างไว�คลิกและลาก
คอลัมน�ท่ีต�องการทําซํ้าไปวางในตําแหน!งท่ีต�องการหรือคลิกขวาและเลือก Duplicate ใน Drop 
Down Menu ส!วนใหญ!จะใช�เพ่ือสร�าง Text Labels ใหม!เพ่ือไป Combine กับ Text Labels อ่ืน
เพ่ือเพ่ิมเนื้อหาในการวิเคราะห�เชิงลึก 
 

 

 

 
Combining Labels ผสมเนื้อหาและสร�าง Labels ใหม� 

 
 หนึ่งในการคุณสมบัติชั้นยอดของ Matrix คือการผสมเนื้อหาเข�าด�วยกันเพ่ือดูผลท่ีแตกต!าง

ออกไปโดยใช� Boolean Operators: And, Or และ Not มาช!วย 
 เม่ือมีการผสมเนื้อหาเข�าด�วยกันจะมีตัว F อยู!ข�างหน�าส!วน Default Boolean Operator 

คือ And เพียงแค!คลิกแล�วลากคอลัมน�หนึ่งไปต!อท�ายคอลัมน�ท่ีทําซํ้ามาก็จะได�คอลัมน�ท่ีผสมเนื้อหา
ใหม!ข้ึนมา 
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 หากต�องการเปลี่ยน Boolean Operator ให�เลือกคอลัมน�แล�วคลิกไปท่ี And จะปรากฏให�
เล ือก 3 ตัวAnd จะนับจํานวน Instance ทั ้งหมดของทั ้ง 2 Text Labels Or จะนับจํานวน 
Instanceท้ังหมดของ Text Label อันใดอันหนึ่ง Not จะไม!นับจํานวน Instance ของท้ัง 2 Text 
Labels 
 
Create Angles and Measurement Lines 
 การสร�างเส�นวัดระยะและมุมองศา 
 Line Measurement Tool 
 วิธีการต้ังค!าเส�นวัดระยะให�เท่ียงตรง 

 
 เลือก Analysis Menu > Measurement Menu > Line 

 เส�นวัดระยะจะปรากฏข้ึนกลางหน�าจอจะมีตัวเลขแสดงระยะข้ึนมา 
 หลักการต้ังระยะสามารถเปรียบเทียบจากระยะของพ้ืนท่ีหรือสิ่งของใน Movie เช!น 

เส�นบนสนามความยาวของบาร�เบลล�ความยาวของไม�ท่ีเตรียมมา 
 เม่ือวางเส�นวัดระยะอยู!ในระนาบเดียวกับเส�นใน Movie และปรับให�ยาวเท!ากันแล�ว 

ก็สามารถใส!ตัวเลขท่ีตรงกับความยาวของเส�นหรือสิ่งของได�เลย 
 1, 2 ใช�สําหรับยืดหรือหดเส�นจัดเส�นให�ระนาบโดยวาง Cursor ไว�บนเส�นเพ่ือควบคุมไป

รอบทิศทาง 
 3 ใช�เคลื่อนย�ายเส�นโดยวาง Cursor ไว�บนเส�นตรงกลางแล�วลากไปวางในตําแหน!งท่ี 

ต�องการกด Control แล�วคลิกไปท่ี เส�นเพ่ือ Set Line Color (สี ), Line Thickness (ความหนา), 
Vertical Scale (ระยะแนวต้ัง), Horizontal Scale (ระยะแนวนอน), Make Vertical (สร�างเส�นแนว
ต้ัง), Make Horizontal (สร�างเส�นแนวนอน) 
Angle Measurement Tool 
 วิธีการสร�างมุมองศา 

 
 
 Instance Monitor แยกดูแต�ละเฟรมใน Instance 

 1. เลือก Analysis > Measurement > Instance Monitor 
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 2. คลิก Instance ท่ีต�องการเลือก Size และจํานวน Frames ภาพแต!ละเฟรมจะปรากฏ
ข้ึนตามขนาดและจํานวนท่ีกําหนด 

 3. ต�องการดูจาก Row ใน timeline เม่ือเป�ด Instance Monitor ข้ึนมาแล�วเลือก 
Rowท่ีต�องการ Instance ท้ังหมดจะถูกไฮไลท�ไว�เลื่อน Play Head มาอยู!ในตําแหน!งท่ีต�องการเริ่มดู 

 4. กด Control+Tab เพ่ือเลื่อนไปดู Instance ต!อไปหรือ Shift+Control+Tab เพ่ือ
ย�อนกลับไป Instance ก!อนหน�า 

 
 
 Converting Movies แปลงไฟล�ภาพ 
 
1. เป�ด Instance Movie ใน Timeline ท่ี Link Movie แล�ว 

  
 

2. เข�าไปท่ี File > Export > Movies > Convert Movies 
3. ต้ังชื่อโฟลเดอร�ท่ีจะเก็บ Format ภาพเลือก Options เพ่ือต้ังค!า 

 
 
 

4. ใน Options จะมี Video, Audio และ Internet ให� Set 

 
5. ใน Video เม่ือเลือก Setting จะมีหน�าต!างแสดงรูปแบบการบีบอัดภาพให�เลือก 
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 6. คลิก OK เพ่ือ Save ค!าท่ีตั้งไว� 
 7. สามารถต้ังค!า Audio และ Movie ได�ตามภาพด�านล!าง 

  
 
 8. เม่ือต้ังค!าทุกอย!างเสร็จหมดแล�วคลิก OK เพ่ือทําการแปลงไฟล�ต!อไป 

 
สปอร�ตโค�ด โปรแกรมวิเคราะห�เกมการแข�งขัน 
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http://sportstec.com/ 
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โปรแกรมอุปกรณ�ชุดทดสอบการเคล่ือนไหวกีฬา( Sport code) 
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ภาคผนวก ง 
 

หนังสือขอความอนุเคราะห�วีดีโอบันทึกการแข�งขันป�นจักสีลัตเพ่ือเก็บข�อมูลเพ่ือทําการวิจัย 
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